SAFR @ milestone

Installation Guide

SAFR™ Facial Recognition for Milestone XProtect®

SAFR™ is exceptionally accurate facial recognition integrated with Milestone XProtect®. Through vigilant 24/7
monitoring — with live video overlays, automatic bookmarks, and real-time alarms — SAFR taps the power of
Al to overcome the limits of physical security by providing enhanced visibility and situational awareness.
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|. Introduction

If you are already familiar with Milestone XProtect® and what SAFR is all about, then this quick guide can
provide you with all you need to get the two working together. You will:

e Adda userto XProtect® to use for SAFR access.

e Create an Overlay Metadata Driver on the Milestone server for each camera.

e  Ensure the SAFR Desktop app is installed, and the Milestone tab has Milestone server settings configured
and connected to at least one camera.

e  Ensure SAFR Desktop app mode is correct for the events you want triggered.

While this guide describes how to use SAFR from RealNetworks together with Milestone XProtect®, it does not
attempt to take the place of the full user and system administration guides for either product. For more
information on either SAFR or Milestone Applications, review the documentation available from the respective
download portals.

About SAFR

SAFR from RealNetworks is a highly accurate facial recognition platform powered by artificial intelligence that
works with IP cameras and readily available hardware to match faces in real time. SAFR provides industry-
leading performance to offer the following capabilities:

e Scalability that can reliably match against millions of faces in under a second.

e Targeted design to specifically recognize faces in real-world conditions, including people in motion, in dim
lighting, and at occluded angles.

o Non-literal matching that handles multiple variations, including masks, makeup, spectacles, hair styles, and
aging.

e High tolerance to yaw, tilt, and rotation.

e Errorrate tuning to minimize false rejections and false acceptances, or to optimize between the two.

RealNetworks computer vision topped the list for labeled faces in the wild (LFW), achieving a 99.86% accuracy
in a test conducted by the University of Massachusetts, and 0.021 for Wild Faces FNMR, according to the
National Institute of Standards and Technology (NIST).

About SAFR for Milestone

SAFR works by analyzing videos and can be connected to cameras managed by Milestone. SAFR processes each
video feed to detect faces and attempt recognition. The Milestone video feeds are enhanced by adding
overlays to show detected faces and information about each face, such as ID class (Stranger, No Concern,
Concern, or Threat), age, gender, and emotion, all of which are optional. This information and any other
metadata associated with a recognized person are also passed to Milestone for use in alerting.

About Events

SAFR defines events that allow you to take action on different scenarios. Scenarios are grouped by the
following:

realnetworks © 2019 RealNetworks, Inc.
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Grouping Description
ID Class A known person marks as either:
e Threat
e Concern
e No Concern (not a threat or concern).
e Stranger (face detected but not previously

registered)
e Unrecognizable (face detected but not of
sufficient quality for recognition)

Person Type A label defined to identify a person; for example,
staff, visitor, or VIP. These are defined on the SAFR
People management page.

Name (Optional) Enrolled person's first and last name.

Note: Person Type and Name are not applicable for the ID Class of Stranger or Unrecognizable.

Combinations of the three attributes described in the table are used to make a total of 14 possible events.
Following are the events SAFR can generate:

e Unrecognizable face detected.

e  Stranger detected.

e Enrolled person detected without name.

e Enrolled person detected with name <name>.

e Enrolled person detected of type <personType>.

e Enrolled person detected of type <personType> with name <name>.
e Concern person detected without name.

e Concern person detected with name <name>.

e  Concern person detected of type <personType>.

e Concern person detected of type <personType> with name <name>.
e Threat person detected without name.

e Threat person detected with name <name>.

e Threat person detected of type <personType>.

e Threat person detected of type <personType> with name <name>.

About SAFR-Triggered Actions

Any of the SAFR events listed can be used to trigger an action in Milestone. For example:

e ASAFR Threat event can be used to trigger a notification to the security guard and lock doors.
e ASAFR alert for one or more known people types can be used to suppress a motion alert to reduce alarm
fatigue.

realnetworks © 2019 RealNetworks, Inc.
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These are just some of the examples. Any action supported by Milestone can be triggered by any of the SAFR
events.

Bookmarks

SAFR creates bookmarks for every event generated. Bookmarks contain the event message; any string in a
bookmark can be used to find the events associated with that string.

II.  Planning Your System

SAFR allows you to add face detection and recognition to your Milestone cameras. For any of your cameras
where face detection events and bookmarks only are required (no overlays), a single stream license for each
camera is required. If you are licensed for 300 cameras with Milestone, then you can create face detection
events and bookmarks for all 300 cameras with SAFR.

If you want to also display overlays for each of your cameras, an additional stream license is required for each
camera. For example, if you have 300 cameras, then you need 600 stream licenses to process events,
bookmarks, and face overlays with SAFR.

Following is an example of how SAFR is deployed with Milestone XProtect®:

& milestone SAFR

@I == XProtect® Identities
. Events
Smart Client Analytics
—_— Cooo .
000 OO0
% VAR " ooo :
© = ~ ~
‘ |. OO0 — .| Recognition
) - 2 (Cloud or On Premises)
0 0 Video Feeds 0 0
@] — - |. OO0 —m .| N |. QOO0 —m .|

XProtect® Server

A typical deployment requires the following computers:

e  Milestone XProtect®
e One or more machines running SAFR Desktop to process videos
e  Milestone XProtect® and Milestone Admin Tool at monitoring locations

Cameras are connected to Milestone XProtect®. The SAFR app can then connect to Milestone XProtect® to
perform analysis of the video and add overlays. Depending on the number of cameras you need, one or more
machines can run SAFR Desktop, each processing multiple video feeds. The SAFR app processes the video and
returns information to Milestone to overlay the video feeds and generate events. The SAFR Desktop app is also
used to perform various management activities. This could be run on the same system as Milestone Security
Center.

realnetworks © 2019 RealNetworks, Inc.
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System Requirements
Software

e  Milestone XProtect® 2019 R1 or later
e RealNetworks SAFR Desktop for Windows 1.4.142 or later
e Forlocal deployment, SAFR Platform Milestone Edition 1.4.140 or later (not required if using SAFR Cloud)

License Requirements

e Each video stream processed by SAFR for events and bookmarks requires one license stream

e FEach video stream being processed by SAFR for events, bookmarks, and video overlays requires two license
streams

e A Milestone license for the number of video streams needed is acquired through Milestone

e ASAFR license for the number of video streams needed is acquired through RealNetworks

SAFR Desktop System Requirements

e Windows 10

e 16GBRAM

e (Quad Corei7 CPU (6 core or better recommended with NVIDIA GTX 1050Ti, GTX 1060, GTX 1070Ti or GTX
1080Ti graphics card for enhanced performance)

SAFR Desktop can process video for multiple cameras depending on your load and size of the video feed.

Configure Milestone

Following are the steps required to allow SAFR to connect Milestone XProtect® to process video streams or
facial recognition.

1. Create a SAFR user.

Create a user with the desired permissions. SAFR does not require special permissions in Milestone, so this
user can be as restricted as needed.

2. Install SAFR.

From SAFR Download Portal, download the SAFR Desktop for your platform.

e For Windows machines, the full version is intended for machines with NVIDIA video cards. With an
NVIDIA card installed, you can realize significantly improved performance.
e Afterinstallation, proceed to Configuring SAFR app below.

Connecting SAFR with Milestone using the following steps:

e  Start the SAFR app through the Windows Start menu, Mac applications folder, or iOS/Android
desktop.

e Signin to your SAFR Cloud. Your regional SAFR Technical Representative can help you obtain sign-
in credentials.

e Once signed in to SAFR, from the Tools menu, select Preferences to connect SAFR to Milestone.

e  Click the Milestone tab as shown in the following illustration:

realnetworks © 2019 RealNetworks, Inc.
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Preferences n
& ¥ ®) Q2 0O & B8
e & vy |\l @
Account | Milestone | Camera | Detection | Tracking | Recognition | Events | User Interface
Username: Administrator
Password: ssessscssese
Windows credentials
Directory: milestone-vms01.dev.realcv.com
Draw Overlays
Overlay Password: ecesscccee
Active Overlay Connections...
Report Events
(V] Include Event Details
Insert Bookmarks
[ Include Unrecognizable Faces
Include Strangers
Include Enrolled
Include Concerns and Threats
l oK | | Cancel |
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Note: If the Milestone Preferences tab is not displayed, you may have installed an incorrect version of SAFR
Desktop. Ensure you have downloaded the Milestone Edition of SAFR Desktop.

o

Overlay Setup

O O O O O

3.

Create overlay metadata driver on Milestone Server for each camera.

Enter information in the Milestone tab to connect to Milestone XProtect® server, and click OK.
Username: User created previously in Configure Milestone
Password: Password created for SAFR user
Directory: IP address of server running Milestone XProtect®
Check Windows credentials if the user is a Windows system user

Overlay Password: This password is used in setting up the metadata drivers

Open Milestone XProtect Management Client. In the left pane, under Servers, click Recording Servers.
In the center pane, right-click the appropriate server name, and click Add Hardware.

© Milestone XProtect Management Client 2019 R1
File Edit View Action Tools Help
H9 oea

Site Navigation v x

J|Recording Server

Properties -8

= § WIN-DNSRNAL2GHE - (13.12) ~
& {J1 Basics
& License Information
Site Information
=5 Remote Connect Services
[ Audis One-click Camera Connection
=@ Servers
] Fecordng Serer|
&) Failover Servers
1) Mobile Servers
= %@ Devices
o Cameras
& Microphones
@ Speakers
B Metadata
o Input
¢ Output

=] Recording Servers
@

Expand

Add Hardware...

Move Hardware...

Delete All Hardware
Rename Recording Server

Eld Remove Recording Server

2 Refresh

Ctrl+N

F2

=53 Client | e

B Smart Wall

View Groups

£2 Smart Client Profiles

§2 Management Client Profiles

I3 Matrix v

< >

Site Navigation | Federated Site Hierarchy

realnetworks
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In the dialog, click the Manual option, and click Next.

Add Hardware

Add Hardware

This wizard helps you detect and set up hardware.

Hardware detection method:

O Express {recommended)
Automatically detects hardware on the recording server's local network

(O Address range scanning
Scans defined network address ranges and detects hardware models

@® Manual
Detects hardware models for manually entered IP addresses and host names

(O Remote connect hardware
m e Add hardware connected via a remote connect server

The Open Platform Company

Help Next > Cancel

If not already in the list, click Add to include the password from the SAFR > Preferences > Milestone
tab Overlay Password field. Include a user name of your choice, for example, SAFR, for easy reference.

Important: If you make changes to the overlay password on the SAFR > Milestone tab, make sure that
you click OK at the bottom of the window. Then make sure the password on the Add Hardware user
name / password page includes the changed password. If not, the add hardware operation fails.

Once you have edited the user name and password table, click Next.

Add Hardware a X
Specify user name and password if devices are not using the default ones.
Include User Name Password Add
/] actory Defa
admin ssseccee
root oy
Help. < Back Next > Cancel

Click Clear All, select Milestone only, and click Next.

realnetworks © 2019 RealNetworks, Inc.
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Add Hardware

Selectwhich drivers to use when scanning for hardware.
Thy dri selected, thy i

@ CJACT]
&[] Arecont
@ []AXS

(- [] Bosch

(- [] Brickcom
(-] Canon
#-[JHanwha
- [] HikVision
@[] Infinova
#-[]IQEye
@-Juve
@[] LG Electronics
(- [7] Milestone
- [] Mobotix
-] ONVIF

() [] Panasonic
&[] Pelco

(- [] Samsung

A Select All

Clear All

Help < Back

Add the address (IP) and port number of the SAFR client active overlay connections. To find this
information, go to SAFR > Properties > Milestone tab, and click Active Overlay Connections. The dialog
provides a table of camera names, IP addresses, and port numbers.

Important: The password in the Overlay Password field must be included in the Add Hardware, user
name / password table or the add hardware operation fails.

Account | Milestone | Camera

Draw Overlays

8 %% 9l

Detection | Tracking

Username: Administrator
Password: escssessscee

Windows credentials
Directory: milestone-vms01.int2.realcv.com

H | B8

Recognition | Events | User Interface

HikVisionGeneric (10.124.13.46) - Camera 1

Overlay Password: sssssccsce
Active Overlay Connections...
R ww - o,
5 = [m] X
|| Milestone Active Overlay Connections
Camera IP Address Port

10.124.13.69 5302

From the Hardware Model menu, select MIP Driver. Click Add to create more rows for additional MIP

driver addresses and ports if needed. Click Next.

realnetworks
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Add Hardware

Enter information for hardware you want to add.
Opti 1 i d up detecti

Address Port Hardware model

» 10.124.13.69 5302 MIP Driver

(=]

<Back

On connection success, click Next.

Add Hardware

Wait whileyour hardware s being detected.

= dd.
select .

Detected hardware:

Add  Address Port Hardware model

Status

[10.1241369 [5302 [mip Drver

f Success

<Back

Select the Metadata check box. It is recommended you click the Name field for the MIP driver and
rename it to include the name of the camera to assist you when associating the camera with the MIP

driver later. Click Next to add the hardware.

Add Hardware [m] X
Hardware and cameras are enabled per default. Manually enable additional devices to be used.
The hardware and its devices will by i t d names. i enter
Hardware name template: Device name template:
Default v Default v
[ Hardware: Camera [J Microphone [ Speaker ™M Metadata [ Output
Hardware to Add Enabled Name
MIP Driver - 10.124.13.69 | %)
(2 Hardware: “ MIP Driver (10.124.13.69)
3 Metadata port 1: I 17 Orver (10.122.13.69) - Metadeta 1
Help < Back Cancel

From the Add to Group menu, associate the MIP driver with a specific metadata group to make it

easier to locate. Click Finish.

realnetworks
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Add Hardware o X

Selecta default group for all devices types.
ively. select devi indivi

b e

Default camera group: Devices Add to Group

Metadata
Defautt microphone group: &’ MIP Driver (10.124.13.69) - Metadata 1 Defautt Group N
No group selected...

No group selected

Defautt speaker group:
No group selected...

Default metadata group:
No group selected... &5

Default input group:
No group selected.

Default output group:
No group selected.

Help < Back Finish Cancel

If the menu does not include a choice, or if you receive an Assign Device to a Device Group message,
do the following:

e Inthe left list, to the right of the Default Metadata Group field, click the folder icon.
e Inthe Select Group dialog, in the lower-left corner, click the folder-plus icon to add a group.

Select Group X

D 7 '8 OK Cancel

e Provide a name for the device group, and click OK.

7 Metadata

o AFR MIP

e From the Add to Group menu, you can now select the new device group.

Once the driver has an associated device group, click Finish.

4. Associate the MIP device with the camera.

In the Milestone XProtect Management Client, in the left pane, click Recording Servers and expand
the tree view to display the cameras and MIP drivers.

realnetworks © 2019 RealNetworks, Inc.
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Site Navigation + 1 x |JRecording Server
-G MILESTONE-VMS01-INT2 - (13.13) =] @ Recording Servers
{1 Basics

[&] License Information

Site Information
=2y Remote Connect Services

& Axis One-click Camera Connection
= Servers

@ Recording Servers

ﬂ Failover Servers

] Mobile Servers

=] Q] MILESTONE-VMSO01-INT2
Avigilon 5.0-H3-DO1-IR (10.124.13.34)
=] HikVisionGeneric (10.124.13.46)

=) MIP Driver (10.124.13.68)
¥ MIP Driver (10.124.13.69) - HikVision

3 HikVisionGeneric (10.124.13.46) - Camera 1

With the camera highlighted, in the right-pane, at the bottom of the window, click Client.

Properties -z
Client settings
Related microphone:
\ | [=
Related speaker:
| = ear
Related metadata:
Shorteut:
[ Live multicast
@ Info §3Settings {J Streams @ Record - Motion (@) FisheyeLens T Ever {# Privacy masking
Under Client Settings > Related Metadata, click the = (ellipsis) button.
(SO1INT2 - e — =
50-H3-DO1-R (10.124.13.34) Ratated mcrophone:
23 Wit (0124346 Conra 1
00 o (101241369 [—
@ M G (101261369 Haiin
ettt =

Select devices

Oevice Grovgs _ Recording Servers
= Wendn
© SR
WP Driver (101241365)- Hikviicn

Selected
P WP e (10241369 - oo

oK

@ o hsetinos [ Sreams @ Recerd 2 Moton @Fisheyelens § Evens 3

Cliert B Privacy masking

In the Select Devices dialog, on the Device Groups tab, click to highlight the MIP device you renamed
earlier for easy identification. Click Add so that the device appears in the Selected pane. Click OK.

ecoriog Sever
A Fecardrg Servers
= & MLESTONE \Mso-NT2
5 5040

01241334

145
6 (10126.13.46) - Camers 1
5 (2 MIP Driver (10.124.1369)

A M Driver (10124 1369) - ikVisin

realnetworks

o

Clort setings
Reisted merophone

Reted masces

WP Drver (10.124.1369) - FicVaon

O Live mutscast

e
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In the right Related Metadata field, the MIP device name is displayed and is now associated with the
highlighted camera in the left pane.

Explanation of Milestone Connection Preferences

e Milestone server (used for enumerating cameras as well as publishing events and bookmarks):
o Username
o Password
o Directory (IP address or Host Name of a Milestone server)
o  Windows credentials if user is Windows system user
e Additional options (defaults work for most purposes):
o Draw Overlays

Ovals, names, and other details are drawn to the video stream so it appears in
Milestone software. Drawn information matches what would show in SAFR Desktop,
so non-Milestone settings that affect SAFR Desktop affect what is drawn to
Milestone.

Control over which overlay elements are drawn on video streams are configured
from the SAFR View menu. Choices include:

e Tracking Frames

e Attributes (gender, age, sentiment)
. Names

e Full-Screen Name

e  Recognition Details

e Video

e Detection List

e Performance Metrics

In addition, under SAFR > Preferences > User Interface, the following control the appearance
of the overlays:

o Name Display Time
This is the amount of time the full-screen recognized person name appears.
o Highlight Border Thickness
This controls the thickness of the frames drawn around the faces in the video.
o Overlay Text Size
This controls the size of the text used to display person’s name under their face.
o Overlay Password
This is used in creating the overlay driver.
o Report Events

Only events reported to the SAFR Events server are reported to Milestone.

realnetworks © 2019 RealNetworks, Inc.



SAFR for Milestone Quick Start Guide Page 14

SAFR Modes

Include Event Details

Increases the verbosity of events in attaching JSON to the event that includes all of
the technical details of the event. This is useful if an operator is using macros to
handle the event for decision-making.

Insert Bookmarks

Adds bookmarks to the video stream related to events. Allows operators to search
video for events or recognized person names. Use caution when deciding what to
include since many faces can cause many bookmarks to be created.

Include Unrecognizable Faces

Adds bookmarks when a face detected by SAFR does not have enough information to
determine if it is a stranger or known person. This can become visually noisy and is
disabled by default. Generally useful for areas where nobody should enter.

Include Strangers

Adds bookmarks when a face is determined to be a stranger. Generally useful for
secured areas where only known people should be.

Include Enrolled
Adds bookmarks when a face is determined to be a known person.
Include Concerns and Threats

Adds bookmarks when a face is determined to be a known concern or threat.

SAFR has different modes to control what events are generated. The following is a short summary of the

modes most relevant to Milestone XProtect® integration. For a complete description, see the SAFR

Administration Guide.

e Secure Access: Trigger events only for cardholders (or persons registered directly in SAFR) only when there

is a high confidence match. Useful for secure entry (for example, unlocking doors).

e Smile to Unlock: Same as Secure Access but includes an additional trigger event if the user smiles.

e Enrolled Monitoring: Trigger events for cardholders (or persons registered directly in SAFR) but with lower

confidence.

e Enrolled and Stranger Monitoring: Same as Enrolled Monitoring but triggers events for strangers also.

Verify your connection:

To verify successful connection to the Milestone system, open Preferences > Camera tab. Cameras connected

to the Milestone system should be visible. All cameras connected to the Milestone system have a Milestone

prefix in their names.

realnetworks
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Connect Your Cameras to Milestone

Initially, you need to add the camera to Milestone using the admin tool. The best information on how to do
this is the Milestone XProtect® Administration Guide. However, what follows is a brief explanation of the
procedure:

Open the Administration client.

Go to Recording Servers.

Right-click the Recording Server to which you want to add a camera.

Select Add Hardware.

Select a method to auto-discover the camera. For this example, use auto-discover.

Check the box next to each manufacturer of the cameras you want to add. Click Next.

Add any username and password combination used to connect to the camera.

Cameras appear in the list as they are discovered. Check the box next to each camera you want to add.

The hardware for each camera is listed. Check the box for each part to be added. Types of parts are camera

feeds, microphones, speakers, and others.

10. Hardware parts need to be added to groups. At the left, select the default group for each type of hardware.
At the right, you can override the group for individual hardware parts.

11. Click Finish to add the selected hardware.

O 0 N oA W e

Connecting SAFR to Milestone Video Feeds

Once the camera is in the Video Archiver, it shows up as a Milestone camera in SAFR. If it does not, try closing
and re-opening SAFR.

To get the SAFR enhancement to show up on the Milestone camera feed:

1. Open the SAFR Desktop.
2. Select the Milestone version of the camera (it has Milestone as the first part of the camera name) from the
menu in the main windows (upper left).

On successful connection to the Milestone camera, video from the camera plays in the SAFR Desktop window.
You can see the enhancements by watching the camera's video feed in XProtect®:

1. Open XProtect®.
1. Go tothe Monitoring Task.
2. Dragand drop a camera from the left side into one of the tiles in the middle.

The camera feed should start up and show the same overlays that are in SAFR (for example, ovals, names).
To connect to additional cameras:

1. Open another instance of SAFR Desktop by selecting New from the File menu.
2. Repeat the previous steps to connect to a different Milestone camera feed.

On successful connection to the Milestone camera, video from the camera plays in the SAFR Desktop window.

3. Repeat this process for as many video feeds as desired (up to the capacity of the machine SAFR is installed
on).
4. If more capacity is needed, install SAFR on additional machines and repeat the setup process.

realnetworks © 2019 RealNetworks, Inc.
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Note: By default, SAFR Desktop for Milestone operates in Enrolled Monitoring mode and generates events and
bookmarks into Milestone system for every enrolled person. If a different mode is desired for selected camera,
choose a different mode from the video window mode selector menu.

Restoring SAFR State

When you quit, SAFR stores its state and restores the state upon startup. When restarted, SAFR opens with the
same number of windows and each window restores its previous settings, including the camera to which it was
connected.

Warning: When closing SAFR, from the File menu, use Quit SAFR. Closing SAFR using the Window Close button
only closes the window and you lose the state—settings and connected camera—for that window.

Adding Identities

You can add people through SAFR Desktop or through SAFR APIs. This can be useful for adding threats or
concerns or other enrolled people who may not be suitable as cardholders. To add people through SAFR
Desktop from an image or video file, do the following:

1. Open SAFR Desktop.
Click File > Import Faces.
Select the image.
e Foranimage, each recognized face is enclosed by a box, and you have the option to type a name.
e Foravideo, each recognized person is learned automatically as long as the faces meet the minimum
criteria for recognition.
4. |If faces are not learned, check the settings in the Detection and Recognition tabs in Preferences to ensure
faces meet minimum criteria.
e Detection > Minimum searched face size
e Recognition > To allow identification

Warning: Reducing detection and recognition settings lowers the quality of the reference face and negatively
impacts recognition. It is preferable to increase the quality of your sources than to lower the criteria for
learning.

Warning: Users added to SAFR are not synchronized to Milestone. These users exist only in SAFR.

Editing Identities

It may be desirable to edit people properties to control which events get triggered when that person is
recognized. For example, setting a person's ID Class to Concern or Threat triggers the respective alarms, or
changing a person type to trigger a VIP alert for specific cardholder groups. The most important people
attributes are the name, image, person type, and ID Class.

Attributes Edited through SAFR

The name, image, or person type should be edited through SAFR. Person type defines a person’s role (for
example, staff or visitor), while the ID Class defines the risk level (No-Concern, Concern, or Threat). Person
Type or image can be edited in SAFR Desktop by changing the Person Type on the People screen.
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ID Class and any other attributes of a person are also edited within SAFR People dialog, accessed through the
SAFR app Tools menu. All identities are created by default with an ID Class of Normal or No Concern.

To edit the ID Class of a person, open the People window from the SAFR Desktop Tools menu as follows:

Regroup

Delete

" Tags: CPQ=06761, FCQ=0.6744, FSQ=0.7857, ImageSize=240 x 262,

Robin Pierce

Principal

Female | Age:

RecognitionDate=Dec 14, 2017, 9:57:53 PM, , Source=7D7EFCA9-46F5-53DF

114fbf62-5d00-4a16-a3ea-b65acadd802a

Gregg Clark

Teacher
Male Age:

Tags: CPQ=0.6830, FCQ=0.7333, FSQ=0.6992, ImageSize=240 x 344,

RecognitionDate=Dec 14, 2017, 10:04:10 PM, , Sources=7D7EFC49-46F5-530F -

1283eda8-f5e7-42ea-a124-6c817e063183

Olivia Parkinson

Librarian

Female | Age:

1100e067-991/-4803-91b4-585¢118370a3

Sara Rodriguez

Teacher
Female  Age:

Tags: CPQ=0.6017, FCQ=0.6133, FSQ=0.7177, ImageSize=128 x 154,

RecognitionDate=Dec 14, 2017, 11:37:21 PM, , Sources7D7EFCA9-46F5-530F -

809776e4-6491-41ec-941b-d4as2262cdc

Danilo Ocampo

Teacher
Male Age

Export Refresh

The Person Type and name can be edited by clicking the respective fields on the People screen. To edit ID
Class, double-click the user and choose the desired value from the ID Class menu in the People Edit dialog as

shown in the following illustration:

Yulong Yuan

Identifier: aff7¢c218-ccba-4fd0-9550-e0c865f9d8

Enrolled Since: 11/26/2018 8:28:03 PM

Company: [

Moniker:

Validation Phone:

Validation Email:

Id Class: No-Concern >

Enrollment Expiration: | Never G
Cancel | | Update |

IIl. SAFR for Milestone XProtect® Features

This section describes how SAFR enhances the Milestone XProtect® application through monitoring, viewing

recognition alarms, and bookmarks.

realnetworks
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Monitoring

SAFR for Milestone enhances video monitoring by providing overlays that gives the security personnel more
information, including person types, threat classification, and name. It can even be used to augment the video
views with age and gender information that may be useful in reporting suspects.

The following illustration shows how overlays give more information about the subjects in view:

™ North Hall (10.124.13.47)

™ West Hall (10.124.13.40)

In the previous illustration, you see a registered named user (top left), and a known threat (top right). It also
shows a stranger tailgating a known user in the bottom left screen. The information is conveyed as name and
color. The following list describes the different colors used in SAFR overlays:

e  Gray (Unrecognizable): The face does not meet minimum quality values and recognition cannot be
attempted, or a response from attempted recognition has not yet arrived.

e Purple (Stranger): The face meets sufficient quality for recognition but is not recognized and does not meet
minimum quality to be learned.

e Blue: The face is recognized as matching one already in the database. It is blue rather than green since it
has no assigned name.

e  Green: Registered person with a name.

e Yellow: The face has just been learned (recorded in the database).

e Red (Threat): Registered face tagged as a threat.

Viewing Recognition Alarms

You can also use SAFR to view recognition events. Recognition events occur when a known, unknown, or
unrecognized person appears in the view of a camera. The types of recognized persons are:

e Unrecognizable: The face is detected but not of sufficient quality to attempt recognition.
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e  Stranger.
e Enrolled person, with or without name.
e Enrolled person marked as Threat or Concern.

There are 12 different combinations of these conditions that are triggered. The following illustration shows
multiple events populated in the Milestone alerts panel:

@ Milestone XProtect Smart Client 4232019 121:40PM = B X
Setup B
| North Hall (10.124.1335) - 4/23/2019 o North Hall (10.124.1334) - 4/23/2019

Hall (10124 13,34

North Hall (10124 13 34)

hreal person detecied wih name Viren Stimpler, 939% mach

Nams  Now (ftor appied) | Clear it

rorty Level St

RealNetworks

North Hall (10.124.13.34)
North Hall (10,124 13.34)
North Hall (10.124.13.34)
North Hall (10.124.13.34)
North Hall (10,124 13.34)
North Hall (10.124.13.34)
North Hall 10.124.13.34)
North Hall(10.124 13.34)

P
1
1
1
1
1
1
1
1
1
€ 1
1
1
1
1
1
1
1
1
1
1
1

Note: Clicking any of the events on this screen allows the video from that event to be replayed.

Bookmarks

SAFR for Milestone creates bookmarks to help locate important events. Bookmarks are populated with person
type, ID class, and name as described previously. They can also provide more detailed information with even
more search attributes, such as age and gender.

The following illustration shows how bookmarks can be used to review important events, such as the detection
of a stranger tailgating behind a registered user.
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@ Milestone XProtect Smart Client 420201954024 = O X

tve  [PIBRMN  Sequence Explore ager X
XProtect o

™ North Hall (10.124.13.47)

006810
[BASICI\sdc-dev

Note: The purple indicator identifies the person is a stranger.

IV. Troubleshooting Tips

e [f detection or recognition results in not many faces found or recognized, check that the Milestone video
feeds are of a sufficiently large frame size.

e [f events are not being triggered, ensure the SAFR Mode is selected.

e If overlays are not displayed after configuration, the issue may involve a Windows Defender firewall
security alert either before or after your system has been rebooted. The result is that the SAFR application
is blocked. Configure Windows Defender Firewall Inbound Rules to enable SAFR and Client.
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